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Welcome to
ArcExplorer 3.1

• What you can do
with ArcExplorer 3.1

• Installing ArcExplorer 3.1

• How to get help

Welcome to ArcExplorerTM 3.1�JavaTM edition, a geographic data explorer
developed by Environmental Systems Research Institute, Inc. (ESRI). You
can use ArcExplorer 3.1 to view and query geographic data stored on your
computer or on the Web.

ArcExplorer offers tools for viewing and querying your spatial and attribute
data, performing spatial analysis tasks such as selecting and buffering
features, creating a variety of maps such as unique symbols and graduated
symbols, and much more. You�ll be amazed at the ease with which you can
take advantage of these tools.

1
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What you can do with ArcExplorer 3.1

Using ArcExplorer 3.1, you can:

� Pan and zoom the map�s extent.

� Query spatial and attribute data.

� Create a buffer around selected features.

� Measure distances on your map.

� Create one symbol, unique symbols, and graduated symbols map.

� Label map features with many options for effects.

� Locate an address.

� View data from the Geography NetworkSM.

ArcExplorer 3.1 also features legends, overview maps, saving and retrieving projects, and map printing.

Scale Bar

Overview Map

Legend

Toolbar

Menu Bar
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What you need to install ArcExplorer 3.1

ArcExplorer 3.1  can be installed on a Windows® 2000, Windows
NT®, Windows 98, or UNIX® operating system.

How to install ArcExplorer 3.1 on a Windows
operating system

Installing the software

To begin installation, navigate to the AEJavaSetup.exe. This file is
located on the ArcIMS installation CD or the directory where you
downloaded it from the Web.

Starting ArcExplorer 3.1

Double-click the AEJavaSetup.exe and follow the on-screen
instructions.

After installation, click Start | Programs | ESRI |
 ArcExplorer 3.1 to open ArcExplorer 3.1.

Installing ArcExplorer 3.1

How to install ArcExplorer 3.1 on a Solaris
operating system

Installing the software from the ArcIMS CD

SolarisTM  2.x includes Volume ManagementTM software, which
automatically mounts and provides immediate access to your
CD�ROM. When using Volume Management software, place the
ArcIMS® CD into your CD drive. At this point, the ArcIMS disk is
mounted. Type the following command:

% cd /cdrom/cdrom0/Solaris/ArcExplorer3.1

Note: For security reasons, don�t install ArcExplorer 3.1  as root.

Make sure that the user�s account that will install ArcExplorer 3.1
has write permissions to the installation directory.

The �install� command has five options:

Usage:  install  <-help | -load | -remove | -verify | -lmhostid>

Type �install -help� to read more about the installation procedure.

To start the ArcExplorer 3.1 installation, type the following
command from anywhere on your system:

% cdrom/Solaris/ArcExplorer3.1/install -load

This starts the dialog for the menu-driven ArcExplorer 3.1
software installation. Default selections are noted in brackets, [ ].
To obtain a list of options or Help, type �?� at any prompt. You
can quit the installation procedure at any time by typing �quit� or
�q�. To return to a previous question, type the caret, �^�.

Installing the software from the web download

After downloading the ArcExplorer.tar.Z file, move it to the
directory where you wish to install ArcExplorer 3.1.  Use the
uncompress command:

%uncompress ArcExplorer.tar.Z
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and then tar:

%tar xvf ArcExplorer.tar

The �install� command has five options:

Usage:  install  <-help | -load | -remove | -verify | -lmhostid>

Type �install -help� to read more about the installation procedure.

To start the ArcExplorer 3.1 installation, type the following command in the directory where you downloaded the files on your system:

%./install -load

This starts the dialog for the ArcExplorer 3.1 software installation procedure, which is menu driven.

Default selections are noted in brackets [ ]. To obtain a list of options or Help, type �?� at any prompt. You can quit the installation
procedure at any time by typing quit or �q�. To return to a previous question, type the caret, �^�.

Setting up your account

ESRI recommends that you execute ArcExplorer 3.1 from a C shell. The following instructions are for a C shell environment setup.

To use ArcExplorer 3.1, add the following lines to your .login or .cshrc file:

setenv AEJHOME <path to ArcExplorer 3.1 installation directory>/aej31exe>

setenv LD_LIBRARY_PATH $AEJHOME/lib

Make sure that $AEJHOME/bin is in the PATH.

set path = ( $path $AEJHOME/bin )

To enable the changes, type:

% source <.login or .cshrc>

Editing the $HOME/aimsclient.properties file

Update the value of the WebBrowser key in the aimsclient.properties file to point to the location of your default browser.

Update the value of the AEJavaHelp key in the aimsclient.properties file to point to the location of the ArcExplorer 3.1 online Help files.

Starting ArcExplorer 3.1

With  $AEJHOME/bin included in your PATH, start ArcExplorer by typing:

aejava
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How to install ArcExplorer 3.1 on IBM AIX operating system

Installing the software from the ArcIMS CD

To install ArcExplorer from the CD, become super user and put the ArcIMS CD into your CD�ROM drive:

% su

You will be prompted for your super user password. If you do not know this password, contact your systems administrator. If a /cdrom
directory does not exist, create one:

# mkdir /cdrom

Now mount the ArcIMS CD:

# mount -v �cdrfs� -p�� -r�� /<dev> /cdrom

(or use smit)

where <dev> stands for the CD�ROM device.

At this point, the ArcIMS CD is mounted.  Before installing ArcExplorer, exit super user mode:

# exit

To start the ArcExplorer 3.1 installation, type the following command from anywhere on your system:

% /cdrom/AIX/ArcExplorer3.1/install -load

This starts the dialog for the menu-driven ArcExplorer 3.1 software installation. Default selections are noted in brackets, [ ]. To obtain a
list of options or Help, type �?� at any prompt. You can quit the installation procedure at any time by typing �quit� or �q�. To return to a
previous question, type the caret, �^�.

After you finished installing ArcExplorer, take the ArcIMS CD out of the CD�ROM drive by unmounting it.

As super user, type:

# umount /<dev>

where <dev> stands for the CD�ROM device.

Installing the software from the web download

After downloading the ArcExplorer.tar.Z file, move it to the directory where you wish to install ArcExplorer 3.1.  Use the uncompress
command:

% uncompress ArcExplorer.tar.Z
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and then tar:

% tar xvf ArcExplorer.tar

The �install� command has five options:

Usage:  install  <-help | -load | -remove | -verify | -lmhostid>

Type �install -help� to read more about the installation procedure.

To start the ArcExplorer 3.1 installation, type the following command in the directory where you downloaded the files on your system:

% ./install -load

This starts the dialog for the ArcExplorer 3.1 software installation procedure, which is menu driven.

Default selections are noted in brackets [ ]. To obtain a list of options or Help, type �?� at any prompt. You can quit the installation
procedure at any time by typing quit or �q�. To return to a previous question, type the caret, �^�.

Setting up your account

ESRI recommends that you execute ArcExplorer 3.1 from a C shell. The following instructions are for a C shell environment setup.

To use ArcExplorer 3.1, add the following lines to your .login or .cshrc file:

setenv AEJHOME <path to ArcExplorer 3.1 installation directory>/aej31exe>

setenv LIBPATH $AEJHOME/lib

Make sure that $AEJHOME/bin is in the PATH.

setenv PATH $AEJHOME/bin

To enable the changes, type:

% source <.login or .cshrc>

Editing the $HOME/aimsclient.properties file

Update the value of the WebBrowser key in the aimsclient.properties file to point to the location of your default browser.

Update the value of the AEJavaHelp key in the aimsclient.properties file to point to the location of the ArcExplorer 3.1 online Help files.

Starting ArcExplorer 3.1

With  $AEJHOME/bin included in your PATH, start ArcExplorer by typing:

aejava
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How to get help

ArcExplorer 3.1 provides several ways for you to get help. In
addition to this book, you can use ArcExplorer Help and ESRI on
the Web to answer your questions.

Getting online help

If you need more information about a specific option or
procedure, use ArcExplorer Help.

Click the Help menu and click Help Contents to open ArcExplorer
Help.

Message Console messages

When ArcExplorer 3.1 encounters an error with data or an
operation, most often a message is posted in the status bar of the
main window.

All messages generated by ArcExplorer 3.1 are posted to the
ArcExplorer Message Console. You can open the Message
Console by clicking the Help menu and clicking ArcExplorer
Message Console.

The message level in the Message Console is set by clicking the
View menu, clicking Message Level, and pointing to one of the

choices.

You can click the File menu and click Save As to save the
messages to a text file.

Visit ESRI on the Web

ESRI home page

ESRI�s home page at www.esri.com has up-to-date information on
ESRI® software and services.

ArcExplorer home page

The ArcExplorer home page at www.esri.com/arcexplorer has

� The latest information about ArcExplorer

� Current frequently asked questions (FAQs)

Be sure to check this site often for all the latest information on
ArcExplorer.
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Adding data layers

• Adding shapefiles

• Adding images

• Working with images

• Adding ArcSDE layers

• Viewing data in a MapService

• Viewing data on the Geography
Network

• Viewing layers in an ArcView IMS
service

• Viewing layers in a MapObjects
IMS service

2
This chapter shows you how to add data layers to ArcExplorer 3.1.

The key functionality of ArcExplorer 3.1 is the viewing of spatial data. This
chapter shows you how to view data that is stored on your computer or
published as an ArcIMS MapService or an ArcView® Internet Map
Server (IMS) or MapObjects® Internet Map Server (IMS) service. You can
also view data on the Geography Network. An ArcIMS MapService allows
the content of a map configuration file to be published on the Internet by
registering it to the ArcIMS Spatial Server and web server.

Data from local sources or the Internet, an ArcSDETM server, or a
MapService can be added to ArcExplorer 3.1.
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Adding
shapefiles
You can add shapefiles to
ArcExplorer 3.1 with the
Catalog. The Catalog is opened
with the Add Layers button.

1. Click the Add Layers button
to open the Catalog.

2. Navigate to the folder that
contains shapefiles.

3. Click a file to add.

4. Click the Add Layers button.

Repeat steps 3 and 4 to add
more shapefiles.

5. Click the Close button to
close the Catalog.

Add Layers

Tip

Refreshing the Catalog
Right-click on Local and click
Refresh to see an updated listing of
folders and mapped drives. Right-
click on a folder and click Refresh
to see an updated listing of files.

Tip

Shapefiles with duplicate
field names are not allowed
Shapefiles that contain duplicate
field names cannot be drawn in
ArcExplorer 3.1 and are thus not
listed in the Catalog.

Adding Favorites
Favorites is a list of shortcuts to
commonly used folders. Right-click
on a folder in the Catalog and click
Add to Favorites.

Tip

3

5

4

2



ADDING DATA LAYERS 11

Adding images
You can work with images in
ArcExplorer by displaying them
as a background layer in your
map configuration file.

See the next pages for details
on working with images and
supported images formats.

You can set a transparency
value on an image using the
Layer Properties dialog. See
Chapter 4, Symbolizing Layers,
for more details.

Adding a single image

1. Click the Add Layers button
to open the Catalog.

2. Click the File Type dropdown
and choose Image Files.

3. Navigate to the folder that
contains an image.

4. Click an image to add.

5. Click the Add Layers button.

Repeat steps 4 and 5 to add
more images.

6. Click the Close button to
close the Catalog.

Adding an
ImageDirectory

In the Catalog:

1. Click the File Type dropdown
and choose Image Files.

2. Navigate to the folder that
contains more than
one image.

3. Click the *ImageDirectory
entry in the Catalog.

4. Click the Add Layers button.

All the images in that folder
are added.

5. Click the Close button to
close the Catalog.

3

5

2

Add Layers

4

2

4

1

3

5

6
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You can work with images in ArcExplorer by displaying them as a
background layer in your map configuration file.

You can add JPEG, TIF, GIF, BMP, or PNG files to  ArcExplorer.

World files are required

A world file contains parameters to transform raster rows and
columns into real-world coordinates.

Many image formats require world files. The world file must use a
three-letter extension, and it can�t have scientific notation.

Displaying an ArcIMS Image Directory

An ArcIMS Image Directory is simply a directory containing
several image files. When you choose the Image Directory from
the catalog window, all images are added into the map.

Setting image transparency

Making an image transparent allows you to view overlapping
images in a single map. You can set the transparency of an image
or ImageMapService with the Layer Properties dialog. From the
Layer Properties dialog, click the General tab to set a
transparency value.

Working with images
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Adding ArcSDE
layers
ArcExplorer allows you to use
ArcSDE and ArcSDE for
Coverages layers once you�ve
added an ArcSDE connection.

Type port:<port number> in the
Instance input box.  If neces-
sary, your ArcSDE administrator
will provide you with the
ArcSDE instance information.
The instance should be listed in
your system�s Services file.

Consult your ArcSDE adminis-
trator if you are not sure if your
system is set up to connect to
an ArcSDE database.

See Understanding ArcSDE,
ArcSDE Administration Guide, and
ArcSDE for Coverages Adminis-
tration Guide for more informa-
tion.

Connecting to ArcSDE

1. Click the Add Layers button
to open the Catalog.

2. Double-click ArcSDE.

3. Double-click Add ArcSDE
Connection.

4. Type the name of the Server.

5. Type port:<port number> for
the ArcSDE instance.

6. If necessary, type a Database
name.

7. Type your User name and
Password.

8. Click Test Connection
(optional). If the connection
succeeds, continue. If the
connection fails, use the
error message to correct the
failure.

9. Click OK to connect.

The ArcSDE database is now
listed in the Catalog.

Adding ArcSDE layers

10.Click a layer to add.

11.Click the Add Layers button.

Repeat steps 10 and 11 to
add more layers.

12.Click the Close button to
close the Catalog.

Tips

Disconnecting from
ArcSDE
Disconnect from an ArcSDE
database by right-clicking on the
ArcSDE server in the left panel of
the Catalog and clicking Discon-
nect.

Connection errors
If your connection to ArcSDE
failed, you can use the Message
Console to see detailed error
messages. To open the ArcExplorer
Message Console, click the Help
menu and click Message Console.

9

Add Layers

2

W

E

3

Q

4

5
6

7

8
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Viewing data in a
MapService
An ArcIMS Spatial Server can
serve a Feature MapService or
an Image MapService. You can
use ArcExplorer to view a
MapService.

A Feature MapService uses the
Spatial Server�s feature stream-
ing capabilities. The server
bundles data and streams it to
the requesting client. Requests
are sent to the server only when
additional data is needed.

Image MapServices use the
Spatial Server image rendering
capabilities. When a request is
received, a map is generated on
the server, and the response is
sent back as an image. A new
map image is generated each
time a client requests new
information.

Typing a MapService name on
the WWW Connection dialog
box is optional. If you do not
specify a MapService name,
you will be connected to all the
MapServices.

1. Click the Add Layers button
to open the Catalog.

2. Double-click the WWW icon.

3. Double-click Add Web Site to
open the WWW Connection
dialog.

4. Type the hostname.

5. Click OK to connect.

The web site’s MapServices
appear in your catalog.

6. Click a MapService.

7. Click a layer in the Feature
MapService or the Image
MapService to add.

8. Click the Add Layers button.

Repeat steps 6 and 7 to add
more layers.

9. Click the Close button to
close the Catalog.

Add Layers

9

Tip

List of MapServices
You must disconnect and reconnect
from the Spatial Server to see an
updated list of MapServices. Right-
click on the machine name and
click Remove and then connect
again.

8

2
3

6

5

4

7
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Viewing data on
the Geography
Network
The Geography Network is a
global network of geographic
information. It provides the
infrastructure needed to
facilitate the sharing of geo-
graphic information between
data providers, service provid-
ers, and users around the world.
You can use ArcExplorer to
access the Geography Network
and discover a wide variety of
geographic content.

You can click the Geography
Network button to open a web
browser to the Geography
Network. Once you have found
data, you can click Add to
ArcExplorer to add that data to
ArcExplorer. Saving the project
will allow you to save a reference
to the data on the Geography
Network.

Learn more about the Geography
Network at
www.geographynetwork.com.

1. Click the Geography Network
button to open a web
browser to the Geography
Network.

2. Use the Geography Network
Explorer to find data.

3. Click Add to ArcExplorer to
add that data to the
ArcExplorer map and legend.

4. Close the web browser.

The data from the Geography
Network is now listed in the
legend.

Geography Network

2

4

3

See Also

See Chapter 4, Symbolizing Layers,
for details on how to set the
transparency of an Image
MapService.
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1. Click the Add Layers button
to open the Catalog.

2. Double-click the WWW icon.

3. Double-click Add Web Site to
open the WWW Connection
dialog box.

4. Type the hostname.

5. Click the ArcView IMS tab.

6. Type a map name and view
name.

7. Click OK to connect.

The web site’s MapServices
appear in your catalog.

8. Click a MapService.

9. Click an Image MapService
in the right panel.

10.Click the Add Layers button
to add the layer.

11. Click the Close button to
close the Catalog.

Viewing layers in
an ArcView IMS
service
From ArcExplorer 3.1, you can
view data on a web site served
with  ArcView IMS.

Add Layers

Q

W

2

6

4

5

7

8
3

9
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1. Click the Add Layers button
to open the Catalog.

2. Double-click the WWW icon.

3. Double-click Add Web Site to
open the WWW Connection
dialog box.

4. Type the hostname as http://
<HOSTNAME>/scripts/
esrimap.dll.

5. Click the MapObjects IMS
tab.

6. Click OK to connect.

The web site’s MapServices
appear in your catalog.

7. Click a MapService.

8. Click an Image MapService
in the right panel.

9. Click the Add Layers button
to add the layer.

10. Click the Close button to
close the Catalog.

Viewing layers in
a MapObjects
IMS service
From ArcExplorer 3.1, you can
view data on a web site served
with MapObjects  IMS.

Entering a service name to a
MapObjects IMS server on the
WWW Connection dialog box
is optional. If you do not
specify a service name, you will
be connected to all the services.

Add Layers

9

Q

6

4

5

2
3
7

8
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Properties of the legend,
overview map, and scale bar

• Using the legend

• Adding an overview map

• Working with the scale bar

This chapter introduces the ArcExplorer 3.1 interface. You will learn how to
set up and use the legend, overview map, and scale bar.

Terms used throughout this book in referring to the interface are defined in
this chapter.

3
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Using the legend
All layers in a map are listed to
the left of the map in the legend.
The legend shows the layer name
and the symbol used to draw
each layer. The check box next to
each layer indicates whether it is
currently turned on or off in the
map, that is, whether it is
currently drawn on the map or
not.

The order in which the layers are
listed in the legend is also
important. The layers at the top
of the legend are drawn on top of
those below it. Layers that form
the background of your map are
listed at the bottom of the
legend. To change the order a
layer is drawn in, drag the layer
up or down in the legend. The
Move Layer choice on a layer�s
right-click menu gives options
for moving the layer.

You can change the width of the
legend by dragging the border
between the legend and the map
either left or right. This is useful
if you want to increase the width
of the legend so that you can see
long layer names.

You can turn the legend off by
clicking the View menu and
unchecking the Legend choice.

Click the check box to
the left of each layer’s
name to make the layer
draw in the map.
Clicking again will turn
the layer off.

Make a layer active by
clicking on its name in the
legend. Many operations
work only on active layers.
When a layer is active, it
appears raised in the
legend.

Use these arrows
to  maximize or
minimize the width
of the legend.
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Double-click a layer to
open the Layer
Properties dialog box.

Right-click a layer to
open a menu of choices
for the layer.
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Adding an
overview map
The overview map displays the
full or partial extent of a layer
with a red box outlining the
current extent of the map. A full
or partial extent is displayed
depending on how far you have
zoomed in.

Opening an overview
map

1. Click the View menu and
check Overview Map to add
an overview map panel.

Adding a layer to the
overview map

1. Right-click on a layer listed in
the legend and click Use in
Overview Map.

To remove the layer, repeat
step 1 to uncheck Use in
Overview Map.

1

1

Tip

Using the overview map
when zoomed in
Zooming in very close to a feature
will result in a zoomed in map that
may not have a red outline.
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Working with the
scale bar
Each time you zoom in, zoom
out, or resize the map, the scale
changes. These changes are
reported on the scale bar.

The scale bar consists of a
representative fraction (RF)
(1:24,000), a ruler with distance
markers, and an equation (one
inch = 40 miles). The fraction
(RF scale) is a common way to
present scale in cartography
and can be read as �one inch on
the screen is equal to
24,000 inches on the ground.�
The equation (sometimes
referred to as a �verbal scale�)
presents the same information
but translates the single unit
(an inch in this example) into a
unit you�d use when getting
around in the real world (e.g.,
miles).

Adding a scale bar

1. Click the View menu and
click Scale Bar.

Setting scale bar
properties

1. Click the View menu and
click Scale Bar Properties.

2. Point to Map Units, Scale
Units, and Screen Units to set
the appropriate units.

1

2

1

Map units

Map units are the units in which geographic
data is stored (data source units). You can set
the map units as decimal degrees, feet, or
meters.

Scale units

Scale units display in the scale bar itself and
in the right side of the verbal scale equation
(1 centimeter = 200 kilometers). You can set
the scale units as miles, feet, meters, or
kilometers.

Screen units

Screen units correspond to the actual display
on your computer monitor and are presented
on the left side of the verbal scale equation
(e.g., 1 inch = 40 miles). You can set the
screen units as either inches or centimeters.

Tip

Right-click on scale bar to
set properties
You can also right-click on the
scale bar to open the scale bar
properties menus.
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Symbolizing layers 4
• Getting general information about

a layer

• Setting a layer’s scale factors

• Drawing features with one symbol

• Making a graduated symbols map

• Making a unique symbols map

• Adding labels to a map

• Adding shields to line features

You can communicate complex geographic information more effectively using
maps than with tables or lists because maps take advantage of our natural
abilities to distinguish and interpret colors, patterns, and spatial relationships.
When you display your data on a map, you�ll see distributions, relationships,
and trends that you couldn�t see before.

Choosing how to represent your data on a map may well be your most
important mapmaking decision. Symbolizing your data involves choosing colors
and styles that will represent features. It also involves grouping or classifying
features according to their attribute values.

This chapter shows you how to create attractive maps and use symbolization
as a powerful tool for exploring, understanding, and analyzing your data.
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7

Getting general
information about
a layer
How a layer is displayed can be
changed using the Layer
Properties dialog box.

The General tab allows you to
change the name of the layer as
it appears in the legend and
provides information about the
datafile.

The General tab can be used to
set a scale factor for a layer.

For images and Image
MapServices, use the General
tab to set a transparency value.
Setting the transparency, allows
two overlapping images or
Image MapServices to be
viewed in one map.

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click the General tab.

4. Type a new name in the
Layer Name box to change
the layer’s name.

5. Click the Only show layer in
the following scale range
button to set scale factors.

6. Type a scale to never show
the layer above or below.

7. Click OK to close the dialog
box and see the changes.

6

4

5

Layer Properties

3

See Also

See the next section, �Setting a
layer�s scale factors�,  for more
details on setting scale factors.
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Setting a layer’s
scale factors
You can control the scale at
which a layer displays by
setting its scale threshold. For
example, you could set a U.S.
state boundaries layer to turn
off after you zoom past a certain
point and set the county
boundaries to turn on at the
same scale. Setting up scale
factors can help keep the map
display clean and focused on
relevant data.

When a scale factor has been
set on a layer, the layer will not
appear in the legend once you
go outside the specified scale
range.

Adding scale factors

1. Use the zoom tools to set an
extent for your display.

2. Right-click the layer’s name
and click Scale Factors.

3. Click Set Minimum Scale
Factor if you want the layer to
turn off if you zoom in any
closer.

4. Click Set Maximum Scale
Factor if you want the layer to
turn off if you zoom further
out.

Removing scale factors

1. Right-click the layer’s name,
click Scale Factors, and point
to Remove Scale Factors.

The map will refresh to show
the layer.

2

1

Tip

Setting scale factors on the
General tab
You can also set scale factors on
the General tab of the Layer
Properties dialog box.

4
3
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6

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click the Style box to apply a
new style to the layer.

4. Click the Color box to choose
a color.

5. Click the Size box to apply a
new size to the layer.

6. Click OK to close the dialog
box and see the changes.

Drawing features
with one symbol
The One Symbol classification
displays all the features in a
layer with the same color and
style. When you add a layer to
ArcExplorer 3.1, it is displayed
as One Symbol maps.

Using the Layer Properties
dialog, you can change the
color, size, or style of the one
symbol map.

Layer Properties

3
4
5
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1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click Graduated Symbols.

4. Click a Field.

5. Click a number of Classes.

6. Click a Style.

7. Click a Start and End Color.

8. Click a Start and End Size.

9. Click an entry in the Symbol
column to change its color.

10.Double-click a value in the
Label column to select it.
Enter a new value.

11.Click OK to close the dialog
box and see the changes.

Making a
graduated
symbols map
You can create a graduated
symbols map using the Layer
Properties dialog box.

A graduated symbols map uses
equal-interval classification to
create graduated color and/or
size maps.

Using the equal-interval
classification method, the range
of attribute values is divided
into equal-sized subranges; the
features are then classified
based on those subranges.

Tip

Changing the value’s label
For a graduated symbols map, you
can change the label of each value
by typing a new value in the Label
column. Be sure to press Enter
after adding each new value.

3
4
6

8

Layer Properties
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Q

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click Unique Symbols.

4. Click a Field.

5. Click a Color Scheme.

6. Click a Style.

7. Check Remove Outline to
remove the outline on
features.

8. Click an entry in the Symbol
column to change its color.

9. Double-click a value in the
Label column to select it.
Enter a new value.

10.Click OK to close the dialog
box and see the changes.

Tip

Changing the value’s label
For a unique symbols map, you
can change the label of each value
by typing a new value in the Label
column. Be sure to press Enter
after adding each new value.

Making a unique
symbols map
You can create a unique
symbols map using the Layer
Properties dialog.

The Unique Values classifica-
tion displays features by
applying a different color to
each unique value for a
specified field.

Layer Properties

9

6
5
4
3
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Adding labels to a
map
Add labels to features with the
Labels tab of the Layer Proper-
ties dialog box.

The example on this page
shows the label placement
functionality for point features.
Label placement for lines offers
above-, on-, or below-the-line
options.

Adding labels

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click the Labels tab.

4. Click a field for labels.

5. Click a Font.

6. Click a Size.

7. Check the Bold or Italic
boxes to change the text.

8. Click the Effects button for
more options on changing
the appearance of labels.

9. Click a Color.

10.Click a label Placement.

11.Click an angle of rotation for
the labels.

12.Click OK to close the dialog
box and see the changes.

Adding effects to labels

1. Check Shadow to add a
three-dimensional effect.

2. Check Glow to add a color
around the label.

3. Check Background to add a
colored box under the label.

4. Check Allow Duplicates to
allow all labels to display.

5. Check Use highest text
quality to apply antialiasing.

6. Click OK.

Tip

Using highest text quality
The check box for using the highest
text quality is also referred to as
antialiasing.

When lines are drawn at an angle,
they may appear jagged due to the
number of pixels available to
display them. Antialiasing allows
the line to be smooth by coloring
adjacent pixels in such a way as to
give the edge of the line a more
gradual fade to the background
color.

Clearing labels
You can also clear labels by right-
clicking on a layer in the legend,
clicking Clear, and pointing to
Clear Labels.

Labeling in bold
If you want your labels in bold, use
one of the following fonts for best
text quality: Dialog, Default, Serif,
and Sans Serif.

7

1
2
3
4
5

3

Layer Properties

W
Q

8
9

4

6
5

Tip

Tip

6



32 USING ARCEXPLORER—JAVA

Y

7

Adding shields to
line features
You can add highway shields to
line features using the Labels
tab of the Layer Properties
dialog box.

Adding shields

1. Click a line layer in the
legend to make it active.

2. Click the Layer Properties
button.

3. Click the Labels tab.

4. Click a field for labels.

5. Click a Font.

6. Click a Size.

7. Click a Color.

8. Check the Use Shields box.

9. Click Shields to open the
Shield Properties dialog box.

Using the same shield for all
features

10. Click the Use the same
 shield for all features option.

11. Click a shield type from the
 dropdown list.

Skip to Step 15.

Using different shields

12. Click the Use different
 shields option.

13. Click a Field to specify each
 shield type.

14. Click each Symbol to set the
 shield type for each value.

15. Click OK.

16. Click OK to close the dialog
 box and see the changes.

6

Layer Properties
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Getting and using the
attributes of features 5
• Identifying features

• Finding features

• Searching for features

• Building a query expression

• Selecting features

• Buffering features

• Displaying MapTips

• Measuring distances

This chapter describes how to use ArcExplorer 3.1 to get information about
the features of your data. You can perform queries in ArcExplorer 3.1 by
pointing at features on a map to identify them (spatial queries) or finding
which features meet certain criteria (attribute queries).
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Identifying
features
Suppose you are looking at a
map of the world and you want
to get information about a
particular city. To get informa-
tion about one of the features
on your map, use the Identify
tool. When you click a feature
with this tool, ArcExplorer 3.1
displays the attributes of the
feature in a dialog.

1. Click a layer in the legend to
make it active.

2. Click the Identify button.

3. Click a feature on the map.

4. The results of the Identify are
shown in the Identify Results
dialog.

5. If more than one feature is
found, the features are listed
in the Features panel. Click
each feature to see its
Identify results.

6. Close the dialog box when
done viewing results.

Identify

5
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Finding features
You can use the Find tool to
locate particular features from
the layers in your map. Find
works by searching the layer or
layers you specify for features
with the value you specified.
Only fields that have been
defined as text strings, as
opposed to numeric values, are
searched.

To search for features based on
a numeric value, use the Query
Builder tool described in the
�Building a query expression�
section.

1. Click the Find button.

2. Type any part of a word you
want to find. (Do not use
quotes around the search
string.)

3. Click the layer or layers you
would like to search.

4. Click Find to execute the
search.

5. Click one of the results in the
right panel to make it active.

6. Click Pan To to pan the view
to the selected feature.

7. Click Zoom To to zoom the
view to the selected feature.

8. Click Close when you are
done finding features.

Tip

Image MapService notation
In the Find dialog box shown on
this page, the Find is performed on
an Image MapService. The Image
MapService notation shows the
name of the Image MapService and
the Image MapService�s sublayer
separated by a period. In this
example, the Image MapService is
named World, and the sublayer
used to find features is named
country.

5

2

3

4

8 6 7

Find
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Searching for
features
The Search tool is enabled if
you open a project or
MapService that has been
created with stored queries.

Once a stored query has been
created, the Search tool allows
you to type only a value to
search for rather than a full
query expression.

1. Click a layer in the legend
that has stored queries to
make it active.

2. Click the Search button.

3. In the Search by list, click the
stored query you would like
to use.

4. The Query Expression is
updated as you click a stored
query.

5. Type a search string.

6. Click Search.

7. Click a result in the lower
panel.

The feature is highlighted on
the map.

8. Click Pan To or Zoom To to
locate the result on the map.

9. Click Close to change the
dialog.

7

8

Search

See Also

You can create stored queries using
the Author component of ArcIMS.
See the Using ArcIMS book for
details.

6
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Building a query
expression
A query expression is a precise
definition of what you want to
select. Building a query
expression is a powerful way to
select features because an
expression can include multiple
attributes, operators, and
calculations.

Remember to include single
quotes around values in your
expression that are text strings.
If you choose a value from the
Values box, the single quotes
are added for you.

You can generate a simple set of
statistics on a field by clicking
Statistics. On the Select a field
to get statistics dialog box, you
can click the Use Query
Results? check box to only
calculate statistics on the
selected records.

The results of a query can be
saved to a text file using the
Save button. In the Save dialog
box, type the name of the file
with a .txt extension.

Tip

Working with query results
The results of a query can be saved
to a comma-delimited text file. The
text file can then be used in another
program, such as Microsoft® Excel,
to create a spreadsheet.

1. Click a layer in the legend to
make it active.

2. Click the Query Builder
button.

3. Click a field to query.

4. Click an operator to be used
in the expression.

5. Click a sample value or type
a value for the expression.

6. Verify that the query expres-
sion is correct.

7. Click Execute to perform the
query.

8. Click a field in the Display
Field dropdown to only show
one field in the panel.

The results appear in the
lower panel.

9. Click to select a value or
values from the query results
panel.

10.Click Highlight to make the
selected feature(s) high-
lighted on the map.

11.Click Pan or Zoom to pan or
zoom to the selected fea-
tures.

12.Click Statistics.

13.Click a field to be used for
statistics and click OK.

The statistics are shown in a
separate dialog.

14.Click the Save button to save
the query results to a text file.

3
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Selecting
features
Use the Graphic Selection
button to select features and
then view their attribute values
using the Attributes button.

The Clear All Selection button
clears the selected features in
all layers. To clear the selection
of a particular layer, right-click it
in the legend, click Clear, and
point to Clear Selection.

1. Click a layer in the legend to
make it active.

2. Click the Graphic Selection
button and click either
Rectangle, Circle, Polygon,
or Line.

3. Click and drag to create a
shape for selecting features.

4. Click the Attributes button to
see the values for the
selected feature or features.

If multiple features were
selected, they are listed in
the left panel.

5. Click each feature to see its
attributes.

Attributes

Graphic Selection

Clear Selection

5
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Buffering features
You can create a buffer around
selected features. Once a buffer
has been applied, you can use
the buffer to select features
from another layer. Selecting
features of one layer with the
features of another layer�s
buffer can be applied to solve
many problems. A project to
widen roads may involve
buffering the road features and
then selecting features from a
parcels layer that overlaps the
buffer.

The map units must be set in
order to create a buffer. The
map units are the units your
data is stored in. You can set
the map units by clicking the
View menu, clicking Scale Bar
properties, and pointing to Map
Units.

Tip

Check map units if buffer
seems incorrect
If the buffer is generating unex-
pected results, verify that the map
units are set appropriately. You can
set the map units by clicking the
View menu, clicking Scale Bar
Properties, pointing to Map Units,
and then clicking the appropriate
unit.

1. Click the Buffer button.

2. Type a distance for buffering
the feature.

3. Click miles, meters, kilome-
ters, or feet for the Buffer
Units.

4. Click Apply to see the buffer.

5. Check the box to select
features from another layer.

6. Click a layer to select
features from.

7. Click OK to see the selection
and close the dialog box.

Note: You can view attributes for
any layer on your map including
the one you’ve selected features
from with your buffer. To do this,
make the layer active in the
legend.

Buffer

47
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Displaying
MapTips
MapTips are small popups that
display data for a field you
specify.

You can only display one
MapTip per layer.

Adding MapTips

1. Click the MapTips button to
open the MapTips dialog.

2. Click a layer for MapTips.

3. Click the field you would like
to display in the MapTips.

4. Click Set Map Tips field.

5. The MapTip Field will update
with the field you choose.

Repeat the process for each
layer you would like to
display with MapTips.

6. Click OK to close the dialog
box and begin using
MapTips.

Removing MapTips

Removing MapTips from the
selected layer

1. Click a layer to select it.

2. Click the Clear Selected
MapTips Field button.

Removing all MapTips

3. Click the Clear All MapTips
Fields button.

4. Click OK to close the dialog.

4

3

2

MapTips

Tip

Clearing MapTips
You can clear a layer�s MapTips by
right-clicking on the layer in the
legend, clicking Clear, and pointing
to Clear MapTips.
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Measuring
distances
Use the Measure button to
measure distances on your map.
Use the measure tool to specify
a measurement unit. You can
measure distances on your map
in feet (ft), miles (mi), meters
(m), or kilometers (km).

The map units must be set
appropriately in order to get
accurate measure results. The
map units are the units your
data is stored in. By default,
ArcExplorer 3.1 sets the map
units to decimal degrees.

Measuring a distance

1. Click the Measure button.

2. Point to one of the measure
units.

3. Click and drag a line defining
the distance you would like
to measure.

The segment and total
measurements appear in the
upper left corner of the map.

Clearing the measure
totals

1. Double-click on the map to
clear the measure totals and
end measuring.

Tip

Check map units if
measure results seem
incorrect
If the measure results seem
incorrect, verify that the map units
are set appropriately. You can set
the map units by clicking the View
menu, clicking Scale Bar Proper-
ties, pointing to Map Units, and
then clicking the appropriate unit.

Clearing measure totals
You can clear the measure totals by
clicking the Measure button and
clicking Clear Measure Totals.

See Also

See the �Working with the scale
bar� section in Chapter 3 to learn
more about setting the map units.

Measure

2
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Address matching 6
• Locating an address

Addresses are probably the most commonly used form of geographic data.
Geocoding is the process by which you add point locations defined by street
addresses, or other address information, to your map. It�s the computer
equivalent of pushing pins into a street map on your wall. Address matching is
a type of geocoding. You can do single record address matching on Image or
Feature MapServices using ArcExplorer 3.1.
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Locating an
address
The Locate Address button
performs an address match: the
locating of a point based on a
text string of address values.

The Locate Address button is
enabled on viewers that have
MapServices created with
geocoding properties set up.

As more than one layer in a
service could have geocoding
properties set, use the Select
Layer dropdown box to select the
layer you would like to use to
locate an address.

After locating an address, use
the Clear Selection button to
clear the point and label from the
map.

1. Add a layer from an Image or
Feature MapService that has
geocoding properties set.

2. Click the Locate Address
button.

3. Click the layer that you would
like to locate an address
from.

4. Type the values of the
address. The more informa-
tion entered, the more
accurate your results will be.

Fields that are required to
perform the address match
appear in red.

5. Click Locate.

6. The results of the address
match appear in the lower
panel. Also, a point and a
label are placed on the map.

7. Click Pan To or Zoom To to
locate the result on the map.

8. Click Close to close the
dialog box.

See Also

You can set a MapService�s
geocoding properties using the
Author component of ArcIMS. See
Using ArcIMS for more details.
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Locate Address
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Printing, copying, and
saving 7
• Printing a map

• Copying a map to a file

• Saving a project

You�ve displayed your data in a map. You�ve chosen the symbols you want to
use. This chapter outlines how to print a map; copy your map to an image; and
save your work as a project (.axl file), also referred to as a map configuration
file.
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Printing a map
Use the steps outlined in
Chapter 4, �Symbolizing layers�,
of this book to symbolize your
data. Then use the Pan and
Zoom tools so that the display in
the map looks the way you want
it to look on paper.

ArcExplorer 3.1 provides a
simple, 8 1/2� x 11�-size map
layout in landscape (horizontal)
format.

1. Click the Print button.

2. If necessary, change the
printer settings.

3. Click OK.

Print

See Also

See the �Copying a map to a file�
section in this chapter for details
on how you can save your map
image to a JPEG file. Once the map
is saved as an image, you can use
it to design your own print layouts.

3

2
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Copying a map to
a file
Use the steps outlined in
Chapter 4, �Symbolizing layers�,
of this book to symbolize your
data. Then use the Pan and
Zoom tools so that the display
in the map looks the way you
want it to look on paper.

You may want to copy the
image of a map for use in
another application.
ArcExplorer 3.1 makes it easy to
create a graphic image of your
map.

1. Click the Copy Map Image to
File button.

2. Navigate to a folder.

3. Type a name for the image.

4. Click Save.

A JPEG of your map has
been saved to the selected
folder.

2

Copy Map Image to File

3 4
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Saving a project
ArcExplorer 3.1 saves projects
in files with an .axl extension.
The paths to the data, whether
layers are turned on or off, the
map extent, any classification or
labels applied to layers, and any
scale factors you may have set
are saved. When you create a
project or map configuration
file, you�re not changing or
altering the base data in any
way.

1. Click the Save Project button.

2. Navigate to a folder.

3. Type a name for the project.

4. Click Save.

Projects can be opened in
ArcExplorer 3.1 by clicking
the Open Project button and
using the Open dialog to
navigate to a project.

Save Project

2

43
Tip

Moving  data
When opening a project,
ArcExplorer 3.1 will not prompt
you for any data that may have
moved since you last saved the
project. Instead, it will warn you
with a message that the data cannot
be found.
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